
 
UPUTSTVO AUTORIMA ZA PRIPREMU I PODNOŠENJE RADOVA 

 

OPŠTI PODACI 
Časopis Hemijska industrija (skraćeno Hem. Ind.) je međunarodni časopis koji objavljuje radove iz oblasti 
hemijskog inženjerstva (fenomeni prenosa; modelovanje procesa; simulacija i optimizacija; termodinamika; 
separacioni procesi; reaktorsko inženjerstvo; elektrohemijsko inženjerstvo; petrohemijsko inženjerstvo, opšte 
hemijsko inženjerstvo), biohemijskog inženjerstva (bioreaktori; proteinsko inženjerstvo; kinetika bioprocesa, 
opšte biohemijsko inženjerstvo), inženjerstva materijala (polimeri; metalni materijali; kompoziti; biomaterijali), 
inženjerstva zaštite životne sredine i primenjene hemije. Časopis objavljuje šest svezaka godišnje. 
Uredništvo časopisa očekuje od recenzenata i autora da poštuju dobro poznata pravila profesionalne etike. 

VRSTE RADOVA 
Svi radovi koje objavljuje časopis Hemijska industrija, moraju biti originalni uz to da nisu prethodno objavljeni. 
Časopis objavljuje sledeće vrste radova (broj u zagradi odnosi se na broj strana teksta bez tabela i slika): 

• originalne naučne radove (do 24 strane), 
• pregledne radove koji predstvaljaju koncizne i kritičke osvrte na specifičnu naučnu oblast; ovi radovi sunajčešće 

po pozivu glavnog i odgovornog urednika (do 36 strana uz to da rad sadrži najmanje 10 autocitata radova sa SCI 
liste uključujući sve autore), 

• stručne radove koji predstavljaju opisrazvoja ili unapređenja određene tehnike, uređaja ili procedure, u cilju veće 
upotrebljivosti rezultata izvornih istraživanja, širenja znanja i primene u industriji (do 12 strana), 

• pisma uredniku sa različitom tematikom upućena prvenstveno uredništvu časopisa. 
• stučne radove u sekciji Osvežimo svoja znanja koji predstavljaju pregled određene teme što je posebno atraktivno 

za mlade istraživače, eksperte iz prakse i istraživače koji žele da dobiju uvid u datu tematiku; ovi radovi su po 
pozivu glavnog i odgovornog urednika, 

• predstavljanje knjiga i događaja 

PRIPREMA RUKOPISA 
Rukopisi treba da budu napisani na srpskom ili engleskom jeziku (ili standardnom britanskom ili američkom 
engleskom, ali ne mešati ova dva). Autorima kojima engleski jezik nije maternji jezik predlaže se da rad pre 
podnošenja u časopis daju na lekturu. Ovo uputstvo se odnosi na radove pisane na srpskom jeziku dok za 
radove na engleskom jeziku molimo da koristite Instructions for authors. 

PREUZMITE OBRAZAC (TEMPLATE) ZA PISANJE RADOVA  
U zavisnosti koji pregledač koristite, i kako je on podešen, nekada je potrebno kliknuti na desni taster miša i 
izabrati opciju Save as, ili sličnu. 

Priprema teksta 
Rukopisi moraju biti pripremljeni kao MS Word dokumenti (.doc, .docx ili .rtf). Pri kucanju rukopisa koristiti font 
Calibri veličine 12, dvostruki prored (A4 format) i margine od 2,5 cm sa svake strane. Časopis Hemijska industrija 
zahteva od autora da rukopis sadrži sve slike i tabele na odgovarajućem mestu u tekstu, a ne na kraju rukopisa 
(videti sekciju "Slike i Tabele"). Fusnote bi trebalo izbegavati. Strane moraju biti numerisane redom od samog 
početka rukopisa. 

Naslovna strana 
Prva strana rukopisa treba da sadrži: naslov, imena i prezimena svih autora, kao i naziv i mesto institucija u 
kojima rade. Naslov rada treba da je pre svega sažet i informativan, ali i atraktivan. Skraćenice ne treba koristiti 
u naslovu rada, sa izuzetkom uobičajeno korišćenih izraza (npr. DNK, NMR). Različite institucije autora treba 
označiti arapskim brojevima u eksponentu iza imena autora kao i ispred naziva institucije. Upotrebiti znak * za 
osobu zaduženu za prepisku. Ime autora zaduženog za prepisku dati na dnu naslovne strane sa nazivom i punom 
adresom institucije u kojoj radi, uključujući i elektronsku poštu. 

http://ache-pub.org.rs/index.php/HemInd/Instructions
http://ache-pub.org.rs/HI_Template_sr.doc


Izvod  
Na drugoj strani rukopisa dati izvod rada u jednom paragrafu koji sadrži 150-200 reči. Na kraju rada posle 
Literature treba dati naslov, imena autora i nazive institucija, kao i prošireni izvod na engleskom jezikuod 350 
do 400 reči. 

Ključne reči: Dati do 6 ključnih reči posle svakog izvoda (na srpskom i engleskom jeziku). Ne koristiti reči koji se 
pojavljuju u naslovu. 

Struktura rada 
Rad treba da bude podeljen u jasno definisane i numerisane sekcije, odnosno da sadrži: Uvod, Eksperimentalni 
deo, Rezultate i diskusiju i Zaključak. Podsekcije takođe treba numerisati, npr. 1.1. (zatim 1.1.1, 1.1.2..), 1.2. itd. 
(Izvod se ne uključije u numerisane sekcije). Kroz tekst rukopisa se treba pozivati na numerisane sekcije, ne 
navoditi samo "u tekstu" ili "u poglavlju...". Svaka podsekcija treba da ima kratak naslov naveden u posebnom 
redu teksta. 

UVOD - U Uvodu dati cilj istraživanja, kao i prikaz relevantnih informacija za rad. Izbegavati detaljan pregled 
literature ili rezultata drugih istraživanja. 

EKSPERIMENTALNI DEO (ili Materijali i metode)- Eksperimentalni deo treba da sadrži jasne specifikacije svih 
materijala (čistoću i naziv i državu proizvođača) i instrumenata (naziv i državu proizvođača) koji su korišćeni u 
radu. Primenjene metode treba opisati detaljno, tako da se mogu reprodukovati. Za postupke poznate u 
literaturi dati odgovarajuće literaturne navode i opisati eventualne izmene. Neophodno je da se navede broj 
ponovljenih eksperimenata ili replikata. Uz to, preporuka je da se uključi odeljak o statističkoj obradi rezulata. 
Prikaz novosintetisanih jedinjenja u radu trebada bude praćen adekvatnim dokazima o njihovoj karakterizaciji 
(tačka topljenja ili tačka ključanja, UV-Vis, IR, NMR, MS i/ili analiza elemenata). Ukoliko su jedinjenja poznata, 
navesti odgovarajuće literaturne navode (npr. za tačku topljenja). 

REZULTATI I DISKUSIJA - Rezultati i diskusija mogu biti napisani odvojeno ili zajedno. Rezultate izneti sažeto, a u 
diskusiji uporediti značaj rezultata sa relevantnim podacima iz literature, ali ne ponavljati rezultate. Kritička 
diskusija rezultata je neophodna u originalnim naučnim radovima i preglednim radovima. 

ZAKLJUČAK - Zaključak treba da prikaže zbirno glavne rezultate i zaključke rada. 

NOMENKLATURA (po slobodnom izboru) - Nomenklatura nije obavezna, ali ako autori žele mogu uključiti u 
rukopis listu simbola koji se koriste u radu. 

ZAHVALNICE – Zahvalnice treba svesti na minimum. 

LITERATURA –Literaturne navode u tekstu treba označiti brojevima u uglastim zagradama, a zatim ih uzastopno 
nabrojati kako slede u tekstu (npr. [1], [3-6]). Spisak literature korišćene u radu treba započeti na posebnoj 
strani, a urediti je tako da prati tekst rukopisa sa ostavljenim praznim redom između svaka dva navoda. Dati 
imena svih autora u literaturnom navodu (prezime i inicijali) i ne koristiti „i drugi” ili „et al.”. Skraćenice naslova 
časopisa napisati u skladu sa usvojenim nazivima datim u bazi Chemical Abstracts. 
Preporučujemo da koristite Mendeley, besplatan menadžer referenci (www.mendeley.com) and HemInd 
Citation Style, koji se može preuzeti samo odavde: http://www.ache-pub.org.rs/HemInd.csl 
 
Primeri: 
[1] Smith WV, Cudra JH, Cambell HN. Kinetics of alkane pyrolysis. J Chem Phys. 1958; 15: 338−356 
https://dx.doi.org/doi*. 
[2] Levenspiel O. Chemical Reaction Engineering. 3rd ed., New York, NY: John Wiley & Sons; 1999 
https://dx.doi.org/doi*. 
[3] Solensky R. Drug allergy: desensitization and treatment of reactions to antibiotics and aspirin. In: Lockey P, 
ed. Allergens and Allergen Immunotherapy. 3rd ed. New York, NY: Marcel Dekker; 2004:585-606 
https://dx.doi.org/doi*. 
  

https://www.mendeley.com/
http://ache-pub.org.rs/index.php/HemInd/management/settings/workflow#submission//HemInd.csl
https://dx.doi.org/doi*
https://dx.doi.org/doi*
https://dx.doi.org/doi*


Ukoliko literaturni navodi nisu na srpskom, engleskom, francuskom, nemačkom ili ruskom jeziku, onda se jezik 
kojim je pisana referenca stavlja u zagradu na kraju referentnog citata, na primer: 
[4] Savaşkan M, Taptık Y, Ürgen M. Deney tasarımı yöntemi ile matkap uçlarında performans optimi-zasyonu. 
İTÜ Dergisi/Mühendislik. 2004; 3: 117–128 https://dx.doi.org/doi*. (na turskom) 
[5] Delević VM, Zejnilović RM, Jančić-Stojanović BS, Zrnić Ćirić MD, Đorđević BI, Stanković IM. Uticaj termičkih 
tretmana na sintezu akrilamida i njegova kvantifikacija metodom gasne hromatografije sa azot–fosfornim 
detektorom. Hem Ind. 2016; 70: 31-36 https://dx.doi.org/doi*. 
*doi treba zameniti doi brojem članka koji se citira, na primer: https://dx.doi.org/10.2298/JSC161212085B (kao aktivni link). Ako 
doi ne postoji, navesti link ka onlajn verziji publikacije, ili ISBN za knjige. 

Ukoliko se citira zbornik radova sa konferencije, standard ili patent, treba ih navesti kao: 
[6] Surname AB, Surname CD. Title of the Proceeding. In: Proceedings of Name of the Conference or Symposium. 
Place of the Conference, Country, Year, pp. 100-102. 
[7] EN ISO 250: Title of the Standard. Year 
[8] Inventor AB, Inventor CD. Title of the patent. Country Code and patent number, registration year 

Citate internet strana bi trebalo izbegavati, ali ukoliko su neophodni onda bi trebalo da uključuju imena autora, 
ukoliko postoje, naslov, internet stranu i datum pristupa: 
[9] Wright NA. Naslov onlajn citata. puna internet adresa. pristupljeno 7. juna 2014. 
[10] Naslov WEb stranice. Puna internet adresa. pristupljeno 7. juna 2014. 

Za literaturu koja nije dostupna neophodno je navesti referencu iz baze Chemical Abstracts u uglastim 
zagradama nakon reference: 
[11] Boixassa A, Pons J, Solans X, Font-Burdia M, Ros J. New dinuclear Pd(II) complex with pyrazolate bridges. 
Synthesis and crystal structure of [Pd(μ-pz)(pzH)2]2(BF4)2 (pzH=pyrazole). Inorg Chem Comm. 2003; 6: 922-925 
[C. A.139/2003 357348t] 

TABELE – Tabele moraju biti uključene u tekst rada i moraju pratiti paragraf u kome se pominju po prvi put u 
tekstu (sve tabele moraju da budu pomenute u tekstu). Tabele numerisati arapskim brojevima po redu kako se 
pojavljuju u tekstu. Iza rednog broja tabele treba da stoji njen kratak, ali opisan naslov (npr. Tabela 1. Pregled 
rezultata...). Naslovi iznad tabela treba da omoguće razumevanje tabele bez čitanja teksta rada. Pored naslova 
na srpskom jeziku treba dati i naslov na engleskom jeziku. Tabele pripremiti korišćenjem funkcije za pravljenje 
tabela u programu WORD, tako da budu vidljive samo horizontalne linije. Minimalna veličina slova u tabeli treba 
da bude 10. Kolone u tabeli ne smeju biti formatirane korišćenjem višestrukog razmaka. Redovi u tabeli su 
ograničeni na širinu margina i ne smeju se formatirati korišćenjem tipke ”Enter” ili “↵”. Tabele ne smeju biti 
uključene u tekst kao grafički objekti. Fusnote se daju ispod tabele, u eksponentu, malim slovima, sa 
jednostrukim proredom i odvojene tačkom i zapetom. U tabelama ne davati rezultate koji su već prikazani u 
nekom delu rukopisa (npr. na slikama). Broj tabela svesti na minimum. 

SLIKE - Pod slikama se podrazumevaju fotografije, šematski prikazi i dijagrami. Slike moraju biti uključene u tekst 
rada i moraju pratiti paragraf teksta u kome se pominju po prvi put (sve slike moraju da budu pomenute u tekstu). 
Slike numerisati arapskim brojevima po redu kako se pojavljuju u tekstu i dati im naslov sa opisom ispod slike (ne 
na samoj slici). Potpisi ispod slika treba da omoguće razumevanje slike bez čitanja teksta rada. Pored potpisa na 
srpskom jeziku treba dati i potpis na engleskom jeziku. Truditi se da tekst potpisa ispod slika bude informativan uz 
objašnjenje korišćenih simbola i skraćenica. Broj slika svesti na minimum. Slike u elektronskom obliku treba 
pripremiti kao grafičke dokumente u TIFF, EPS formatu ili JPEG formatu (isključivo za slike u boji). MS formati 
(Word, PowerPoint, Excel, Visio) nisu prihvatljivi. Autori su odgovorni za kvalitet podnetih slika. Slike napravljene 
u manjoj rezoluciji treba uključiti u tekst rada, dok se slike u visokoj rezoluciji podnose kao pojedinačne datoteke 
ili arhivirane datoteke (.zip, .rar ili .arj). Slike imenovati kao "Slika" uz odgovarajući broj, npr. "Slika 1". Svaku 
pojedinačnu sliku, kao i bilo koji deo slike (A, B, C...) pripremiti shodno instrukcijama koje slede: 
  

https://doi.org/doi
https://dx.doi.org/doi*
http://dx.doi.org/10.2298/JSC161212085B


TIFF 
TIFF (Tagged Image File Format) je preporučeni format za grafike, crno-bele i slike u boji. 

• Slike u boji treba da budu u RGB modu (samo za onlajn verzije rukopisa). 

• TIFF dokumenti treba da budu u sledećim rezolucijama: 
1. RGB ili nijanse sive: minimum 300 dpi 
2. Crno-bela slika: minimum 600 dpi 
3. Grafik i tehnički nacrt: minimum 1000 dpi 
4. Kombinacija (linije, nijanse sive i/ili RGB): minimum 500 dpi 

• Slike treba da budu bez okvira i naslova. 

• Za ilustracije (ukoliko je moguće) koristiti font Calibri ili Arial i obezbediti odgovarajuću veličinu fonta. 

• Sačuvajte ilustraciju u TIFF formatu koristeći LZW kompresiju. 

EPS 
Za vektorsku grafiku, preporučuje se EPS (Encapsulated PostScript) pri čemu je potrebno zadovoljiti sledeće uslove: 
• ako su uključene rasterske (bitmap) slike, treba ih pripremiti u skladu sa uputstvom za pripremu TIFF formata 
• ako je grafika u boji, koristiti model RGB kodiranja 
• na slikama koristiti isključivo sledeće fontove: Calibri, Arial, Helvetica, Symbol 
• praznine između delova jedne slike (npr. a, b, c...) treba ograničiti na minimum uz to da se zadrži jasnoća slike 
• koristiti debljine linija u opsegu 0.35 pt - 1.5 pt 
• na završnoj slici, svi slojevi moraju biti spojeni u jedan sloj (Flatten Artwork) 

JPEG 
JPEG format (Joint Photographic Experts Group) je prihvatljiv samo u slučaju slika u boji. Slika u JPEG formatu 
može da se kreira u kvalitetu od 1 do 12 (nizak, srednji, visok ili maksimalan), pri čemu treba obezbediti da 
veličine dokumenata budu minimalne radi lakšeg prenosa. 

Veličina slika 
Časopis Hemijska industrija teži tome da sve slike u okviru jednog rukopisa budu ujednačene. Iz tog razloga treba 
imati na umu stil koji časopis primenjuje. 
Generalno pravilo je da veličina slova na slici ne treba da bude manja od 11 za normalan tekst i ne manja od 7 
za oznake u eksponentu ili indeksu. Slova manje veličine biće nečitljiva. Ovo pravilo nije striktno, ali se pokazalo 
u praksi kao važno. Postoje slučajevi gde boja i senčenje teksta diktiraju konačnu veličinu fonta, uglavnom je to 
veličina 10. Debljina linija bi trebalo da bude najmanje 1pt. 
U obzir treba uzeti i ostale faktore kada je u pitanju veličina linije na ilustraciji. Sve ovo utiče na čitljivost konačne 
slike. Boje i senke u konačnoj verziji ilustracije treba da se jasno vide u štampanoj verziji. Svi relevantni detalji 
same slike, grafički simboli (kvadrati, trouglovi, krugovi i ostalo), kao i legende na dijagramima (objašnjenje 
upotrebljenih grafičkih simbola) treba da budu jasno vidljivi. 
Opšta uputstva za veličinu slika koje se objavljuju u radovima u časopisu Hemijska industrija su: 

• Minimalna veličina slike: 50 mm širine 
• Veličina male slike – 80 mm širine 
• Veličina velike slike – 120 mm širine 
• Maksimalna veličina slike – 150 mm širine 

U tabeli koja sledi dati su orijentacioni zahtevi u pikselima (širina) po štampanoj veličini i rezoluciji za slike: 
 Širina slike A B C 

Minimalna veličina 50 mm 354 591 1181 

Mala veličina 80 mm 709 1181 2362 

Velika veličina 120 mm 1063 1772 3543 

Maksimalna veličina 150 mm 1417 2362 4724 

A: 300 dpi > RGB/crno-bela slika; B: 500 dpi > Kombinacija (linije/crno-bela/RGB); C: 1000 dpi >Grafik i tehnički nacrt. 
 



Ukoliko je u radu korišćena slika/tabela koja je već objavljena, obavezno treba priložiti dozvolu izdavača tog 
časopisaili knjige za reprodukciju pomenutog materijala u časopisu Hemijska industrija. U potpisu ispod takve 
slike mora se dati odgovarajući literaturni navod u obliku u kome je tražio izdavač koji daje dozvolu za 
reprodukciju materijala. Autori snose odgovornost da pribave sve tražene dozvole za reprodukciju slika/tabela 
(u celosti ili pojedinih delova). 

Jedinice 
Od autora se zahteva da se pridržavaju međunarodno usvojenih pravila i konvencija o primeni SI sistema 
jedinica. Ukoliko se druge jedinice pominju u radu, autori se mole da daju ekvivalente tih jedinica u SI sistemu. 

Formule i jednačine 
Složene formule i matematičke jednačine moraju biti napisane korišćenjem aplikacije MathType ili MS Equation 
Editor (opcija Insert->Object(Object)->MS Equation Editor ili MathType ako je integrisan u MS Word). Korišćenje 
opcije Insert -> Equation, integrisane u MS Office 2010 ili više verzije, kao i unošenje jednačina u tekst paragrafa 
ili u obliku slika NIJE DOZVOLJENO. Jednačine moraju biti obeležene brojevima po redu pojavljivanja (1), (2) itd. 



 

Simboli, terminologija, skraćenice i hemijska nomenklatura 
Za nazive jedinjenja treba pratiti IUPAC preporuke. Oznake fizičkih veličina stavljati u kurziv kroz tekst 
(uključujući slike, tabele i jednačine), dok jedinice i indekse (osim za indekse koji imaju značenje fizičkih veličina) 
stavljati kao normalan tekst. Font koji se koristi je Calibri. Kod grafika i tabela koristiti kosu crtu da bi se odvojila 
oznaka fizičke veličine od jedinice, na primer: p / kPa, ili j / mA cm-1. 



Ukoliko puno ime fizičke veličine nije moguće izbeći onda se ono piše normalnim slovima i odvojeno od jedinice 
zarezom (npr. Pritisak, kPa; Temperatura, K). Molimo autore da ne koristite ose grafika za dodatna objašnjenja. 
Dodatna objašnjenja se napominju u potpisima slika i/ili u tekstu rukopisa (npr. izbegavati naziv poput „pritisak 
na ulazu u sistem, kPa“). Ime ose treba da prati pravac ose (ime ordinate treba da bude rotirano za 90°). 
Latinske reči, kao i imena vrsta, stavljati u kurziv, na primer: i.e., e.g., in vivo, ibid, Calendula officinalis L., itd. 
Grananje organskog jedinjenja stavljati u kurziv, na primer: n-butanol, tert-butanol, itd. 
Za decimalno razdvajanje (decimalni separator) u tekstu na srpskom jeziku, uključujući tabele i slike mora se 
koristiti zapeta, a ne tačka, osim u slučaju delova teksta na engleskom jeziku (prošireni izvod i naslovi slika i 
tabela) gde se koristi tačka kao decimalni separator. 

DODATNI MATERIJAL 
Autori se pozivaju da predstave informacije i rezultate koji nisu od suštinskog značaja za razumevanje njihovog 
rada kao Dodatni materijal (može da se podnese u koraku 2 pri Online podnošenju rada). Ovaj materijal po 
pravilu uključuje, ali nije ograničen na: predstavljanje analitičkih i spektralnih podataka koji pokazuju identitet i 
čistoću sintetisanih jedinjenja, tabela koje sadrže neobrađene podatke na kojima su zasnovani proračuni, serije 
slika od kojih bi jedan primer bio u glavnom tekstu, itd. Uredništvo časopisa zadržava pravo da dodeli takve 
informacije i rezultate iz rada u Dodatni materijal, kada to smatra za potrebno. Dodatni materijal se ne pojavljuje 
u štampanom obliku, ali se može preuzeti sa internet strane časopisa Hemijska industrija. 

PISMO UREDNIKU 
Uz rukopis se mora priložiti pismo Uredniku (isključivo se podnosi u koraku 2 tokom Online podnošenja rukopisa 
kao Dodatni fajl). Pismo Uredniku mora da sadrži naznaku vrste rada koji se podnosi i izjavu kojom autor(i) 
garantuju da je podnet rukopis originalno delo koje nije prethodno objavljeno i koje je napisano i odobreno od 
strane svih autora, kao i institucije u kojoj je rad obavljen. Takođe, treba dodati da rukopis nije istovremeno 
podnet za publikaciju u nekom drugom časopisu i da neće biti podnet za potencijalnu publikaciju dok je u 
procesu recenzije u časopisu Hemijska industrija, a ako bude prihvaćen za štampu da neće biti publikovan u 
drugim publikacijama uključujući i elektronske, i to u istom obliku, na srpskom ili bilo kom drugom jeziku bez 
pisane saglasnosti izdavača. Pismo Uredniku takođe treba da uključi izjave o konfliktu interesa, o pristanku i 
etičkim odobrenjima tamo gde je to potrebno. U Pismu takođe treba navesti novinu i naučni doprinos rada. 
Takođe, neophodno je predložiti tri potencijalna recenzenta. Recenzenti treba da budu eksperti iz oblasti rada 
ali ne smeju biti povezani sa intitucijama autora. Krajnju odluku o izboru recenzenata donosi isključivo Urednik. 
Takođe, autori mogu da navedu i osobe za koje ne žele da budu recenzenti. 

UČEŠĆE U TROŠKOVIMA OBJAVLJIVANJA 
Kako je časopis Hemijska industrija u režimu otvorenog pristupa sadržaju časopisa, za svaki rad prihvaćen za 
objavljivanje autori se obavezuju da će učestvovati u troškovima štampanja u iznosu od 100 € + 20 € PDV (za 
autore iz Srbije iznos se uplaćuje u dinarskoj protivvrednosti po srednjem kursu Narodne Banke Srbije na dan 
uplate). Po prihvatanju rada za objavljivanje, kancelarija izdavača će autorima izdati predračun sa uputstvom za 
plaćanje. Molimo autore da imaju u vidu da uredništvo časopisa neće moći da nastavi sa procesom objavljivanja 
ukoliko učešće nije uplaćeno. 

ŠTAMPANA KOPIJA 
Štampana kopija izdanja časopisasa objavljenim radom je dostupna za autore po ceni od 20 € + 10 % PDV 
uključujući transport i troškove slanja za autore u zemlji, odnosno 50 € + 10 % PDV za autore u inostranstvu. 
Profakturu sa instrukcijama za uplatu možete dobiti kontaktirajući kancelariju Saveza hemijskih inženjera Srbije 
na elektronsku adresu: shi@ache.org.rs ili na telefon +381 11 3240 018. 

PROMENE AUTORSTVA 
Autorstvo može da se promeni samo pre nego što je rukopis odobren za objavljivanje. 
Autor zadužen za prepisku mora poslati zahtev uredništvu časopisa da doda ili ukloni ime autora, ili da promeni 
redosled imena autora. Zahtev mora da uključi: 

• razlog zašto se ime dodaje ili uklanja, ili razlog zbog čega se preraspoređuju imena i 

http://ache-pub.org.rs/index.php/HemInd/management/settings/workflow#submission/mailto:shi@ache.org.rs


• pisanu potvrdu od svih autora (uključujući i autora čije ime se dodaje ili uklanja) da se slažu sa 
predloženim izmenama. 

Zahtev se može poslati putem elektronske pošte, faksa ili pisma. Ukoliko zahtev nije kompletan, objavljivanje 
rukopisa će biti obustavljeno do trenutka postizanja dogovora među autorima. 

DETALJAN POSTUPAK PODNOŠENJA RUKOPISA  
Rukopisi se podnose Online prijavljivanjem na internet stranici časopisa Hemijska industrija (http://ache-
pub.org.rs/index.php/HemInd/). Registracija u ulozi autora i prijava na internet stranici časopisa su neophodni 
da bi se rukopis podneo i da biste mogli da proveravate trenutni status podnetog rukopisa. 
Nakon prijavljivanja, izaberite opciju "Započni novu predaju". 
U koraku 1 pri Online podnošenju rukopisa molimo da uradite sledeće: 

1. Izaberete jezik rukopisa koji podnosite (srpski) 
2. Izaberete odgovarajuću sekciju za rad koji podnosite  
3. Popunite spisak predaje i potpišete izjavu o autorskim pravima. Isto tako u ovom koraku, možete 

eventualno dodati komentar uredniku u polje "Komentari za urednika", s tim da treba imati na umu da 
ovo nije mesto za zvanično Pismo Uredniku (Cover Letter). Zvanično pismo Uredniku mora biti podneto 
u koraku 2 kao jedan od obaveznih dokumenata). 

Korak 2 omogućava dodavanje dokumenta rukopisa i svih drugih dodatnih dokumenata: 
1. Pismo Uredniku, obavezno 
2. Ilustracije, obavezno ako postoje u rukopisu. Moraju biti u .tif, ili .eps fotmatu (.jpg format je dozvoljen 

samo fotografije), dostavljene kao posebne datoteke ili jedana arhivska datoteka (.zip, .rar, .arj....) i 
pripremljene prena Uputstvu za autore. Maksimalna dozvoljena veličina pojedinačne datoteke je 32 MB. 

3. Dodatni materijal (opciono, neće biti štampan u papirnoj verziji već samo dostupan na internet strani 
časopisa). 

4. Dodatni podaci (opciono, neće biti publikovani). 
Neophodno je označiti odgovarajući "Deo rada" za svaku dodatu datoteku. 
U koraku 3 obavezno morate uneti sledeće metapodatke rukopisa koji predajete: 

1. Imena, afilijaciju i e-mail adresu svih autora (izborom opcije Dodaj autora, možete dodati koliko god je 
potrebno autora) 

2. Naslov i sažetak rukopisa, 
3. Ključne reči na osnovu kojih se vrši indeksiranje rukopisa (nakon svake ključne reči kliknite "enter") 
4. Ustanove i agencije koje su dale podršku za Vaša istraživanja i 
5. Formatiranu listu referenci radova citiranih u rukopisu. 

Korak 4 - Završetak podnošenja. 
Autor za prepisku će dobiti potvrdu o predaji rukopisa putem elektronske pošte i moći će da prati proces 
recenziranja i objavljivanja rada prijavljivanjem na internet stranici časopisa. 
Rukopisi koji nisu pripremljeni u skladu sa Uputstvom biće smešteni u arhivu kao neprikladni i vraćeni na 
ponovno podnošenje. 
U slučaju teškoća pri podnošenju rada, konsultujte generalno uputstvo: https://docs.pkp.sfu.ca/learning-
ojs/en/authoring#submitting-an-article. Ukoliko problem i dalje postoji, molimo da kontaktirate kancelariju 
časopisa putem elektronske pošte - web@ache.org.rs . 

PROCES RECENZIRANJA 
Nakon evaluacije rukopisa od strane recenzenata, autor za korespondenciju će dobiti obaveštenje i izveštaje 
recenzenata putem elektronske pošte. U slučaju zahteva za korekcijama rada, autor za korespondenciju treba 
da podnese revidirani rukopis prema sugestijama recenzenata i detaljne odgovore na komentare recenzenata 
najduže u roku od 60 dana za velike izmene i 30 dana za male izmene. Ukoliko se ne izvrši podnošenje revidiranog 
rada u ovom vremenskom periodu, rukopis će se smatrati povučenim. Da biste podneli revidirani rukopis, 
posetite internet stranicu časopisa Hemijska industrija https://www.ache-pub.org.rs/index.php/HemInd/ i 
prijavite se kao autor (sa registrovanim korisničkim imenom i lozinkom). Molimo Vas da tom prilikom podnesete: 

1. Ispravljen rukopis sa jasno obeleženim revidiranim delovima kao .doc ili .docx datoteku (Deo rada: 
Korigovan rukopis). 
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2. Detaljne odgovore na sve komentar recenzenata kao .doc ili .pdf datoteke (Deo rada: Odgovor 
Recenzentu). 

3. Korigovane Slike imenovane kao: Korigovana Slika: XXX  (Deo rada: Ilustracije). 
Ukoliko je u međuvremenu došlo do promene metapodataka (ili su podaci nepotpuni) obavezno ih korigujete 
(sekcija PUBLIKACIJE). 

Po završetku podnošenja revidiranog rada obavestite Urednika slanjem poruke. 
 


